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1 Introduction

Introduction
INCA-SIP (INCA Simulink Integration Package) is an INCA add-on that provides
measurement and calibration access to MATLAB/Simulink modelled ECU functions via INCA. The INCA-SIP add-on is an additional Simulink Toolbox.
If you follow the instructions in chapter "Installation" on page 7, a new menu
item will be available in Simulink. This menu item establishes a connection
between INCA and your Simulink model.
As part of the connection procedure, INCA-SIP creates various INCA objects
(.a2l, .s19, INCA workspace) based upon the user's model. In addition, INCA-SIP
provides a number of search scripts that enable measuring and calibration of
models using standard Simulink blocks. Customer-specific blocks can also be
measured and calibrated. To support such customer-specific blocks, custom
search scripts need to be written.

1.1

Connecting the Simulink Model to INCA
During the model connection phase, INCA-SIP starts an analysis of the model
blocks (see the upper part in the figure chapter "Measuring and Calibrating the
Model" on the next page). You can customize the analysis to deal with customer-specific blocks through custom search scripts.
After a successful connection, all parameters required for measurements and
calibration access are determined and all artifacts required by INCA are generated.
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1 Introduction

Measuring and Calibrating the Model
Within the INCA environment, the INCA-SIP add-on is presented as an XCP
device. INCA uses XCP to send and receive data to and from INCA-SIP, while
INCA-SIP exchanges data with the model via MATLAB’s COM API interface (see
figure lower part). Measurements from a Simulink model can be received in
INCA when the Simulink model is running, while calibration is also possible even
if the model is not under simulation, i.e. stopped or paused.

Analyzing the model (upper part) and M/C access (lower part) INCA-SIP
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Installation

2.1

System Requirements
To work with INCA-SIP the following requirements must be fulfilled.

2.1.1

Hardware Requirements
The hardware requirements for the add-on are the same as for INCA and
MATLAB/Simulink. Refer to the respective manuals.

2.1.2

Software Requirements
To work with INCA-SIP V7.3 you need the following software components:

2.2

l

INCA V7.3 including current hotfixes

l

MATLAB/Simulink (For supported versions, refer to the release notes.)

Installing the Software
In this section you will find a description of the installation procedure and additional information about start menu entries and MATLAB path modifications.

2.2.1

Installing INCA-SIP V7.3
This section describes how to install INCA-SIP V7.3.
To install INCA-SIP
1. Close all open ETAS programs.
2. Depending on your company-specific regulations, the installation
files are provided on DVD or on a network drive.
By using the DVD, the installation starts automatically. If this is not
the case, execute the Autostart.exe file.
or
If you install the program from a network drive, execute the
Setup_ServicePack.exe.
3. In the column "Install" select the checkboxes of INCA V7.3, MDA,
INCA-SIP and any further add-ons if needed.

2.2.2

Registering a C++ Compiler
If you use Rapid Accelerator Mode in Simulink with INCA-SIP, you need a C++
compiler registered as a MEX compiler. Therefore, prior to using INCA-SIP with
Rapid Accelerator Mode, you have to register an external compiler, such as
MSVC (Visual Studio), as a MEX compiler. To register an external compiler, run
a "mex -setup" in the desired MATLAB version before connecting INCA-SIP to
INCA. For the entire list of supported compilers, refer to the MATLAB documentation.
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2 Installation

Start Menu
The Windows start menu folder contains the following entries once installation
has been completed successfully:
l

l

E → ETAS INCA V7.3 → INCA V7.3 Manuals and Tutorials
Opens a folder containing this manual and other support information.
E → ETAS → ETAS License Manager
Starts the ETAS License Manager where you can view and manage
licenses for your ETAS software products (e.g. adding, borrowing, and
returning licenses).

2.2.4

Licensing the Software
A valid license is required for using INCA and INCA-SIP. You can acquire the
required license file either through the tool coordinator or through a self-service
portal on the ETAS website under http://www.etas.com/support/licensing. To
request the license file, you have to enter the activation code which you received
from ETAS during the ordering process.
In the Windows Start menu, select
E → ETAS → ETAS License Manager.
Follow the instructions given in the dialog.
For further information, press F1 in the ETAS License Manager.

2.2.5

Installation Path of INCA-SIP
The default installation path for INCA-SIP is:
64-bit

2.2.6

<drive>:\Program Files\ETAS\AddOn_SIP7.3\

MATLAB Script Files
If INCA-SIP is installed, the MATLAB script files are stored under the following
directories:
64-bit

<drive>:\Program Files\ETAS\AddOn_
SIP7.3\+MScripts

The folder "+MScripts" contains MATLAB script files that are either called by
INCA-SIP server or used by Simulink to interact with INCA-SIP server and INCA.
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3 Working with INCA-SIP

Working with INCA-SIP
This chapter contains information on preparatory measures and a description of
how to work with INCA-SIP.

3.1

MATLAB Search Path Modification
To make INCA-SIP available in a particular MATLAB version, add the INCA-SIP
installation path using the MATLAB command addpath followed by
savepath. Refer to 2.2.5 "Installation Path of INCA-SIP" on page 8 for path
information.
Once the path is entered, the INCA-SIP menu item will be visible under the
"Tools" menu in the Simulink window.

3.2

Switching between INCA Versions
You can have both INCA-SIP V7.3 and any other INCA-SIP V7.x installed on the
same computer although you use only one version at a time.
However, if you switch between INCA versions, it will be necessary to manually
change the path to the proper INCA-SIP version and to restart MATLAB.
For more information, refer to "MATLAB Search Path Modification" above.

3.3

Menu Items
The INCA-SIP menu item contains the following functions:

3.3.1

l

"Connect to INCA" below

l

"ECUs" on page 11

l

"Configuration" on page 15

l

"MDF Configuration" on page 16

l

Help

Connect to INCA
If you select this feature, INCA-SIP will start processing the associated model
as per the configuration settings. For each enabled ECU definition in INCA-SIP,
the calibrations and measurements are identified and processed. Each ECU
definition is converted to an A2L and an S19 file. When the conversion process is
complete, INCA is automatically opened and a workspace is auto-generated in
INCA. For each ECU, a device is added in INCA with the corresponding project
description and dataset.
INCA-SIP generates an EPK for each ECU.
The EPK is composed of:
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l

A hashing function which considers the calibrations and measurements
present in the ECU

l

The IP address of the network interface the ECU is made available on

l

The associated TCP port

This ensures that a device on INCA will be connected to the appropriate Simulink model in INCA-SIP.
If the model is modified and you attempt to connect to INCA again, INCA-SIP
detects the changes and automatically replaces the datasets in INCA. If you
have an open experiment in INCA, INCA-SIP prompts you to save before closing
the experiment for you.
After the connection process is complete, INCA-SIP leaves the model in a
paused state in "Normal" and "Accelerated" mode. This will speed up the data
collection whenever measuring is started in the experiment window in INCA.
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ECUs
If you select this feature, the ECUs dialog box opens.
You have three options to choose for the ECUs being modelled:
l

Add

l

Configure

l

Delete

INCA-SIP supports two types of ECUs, Simulink and DLL ECUs.
Simulink ECUs represent ECUs that have measurements and calibrations
which exist as blocks within the Simulink model.
Simulink ECUs are divided in two types: Simulink ECU and Referenced Model
Group.
The difference between these two types is that Simulink ECU allows either mapping to the root model or an one to one mapping to Referenced Models. On the
other hand Referenced Model Group only allows one to many mapping to referenced models.
DLL ECUs represent ECUs that are used when an S-Function uses third party
DLLs in order to compute the S-Function result. Such DLLs can have global variables which can be considered as measurements and/or calibrations. DLL
ECUs provide a mechanism that exposes these variables as calibrations and
measurements in INCA.
To add a new ECU in Simulink
1. In the Tools menu, select INCA-SIP→ ECUs.
The "ECUs" dialog box opens.
2. Click Add in the "ECUs" dialog box.
The "Add ECU" dialog box opens.
3. Enter the required information in the following fields:
ECU Name: Name of the ECU. This field is Macro Compliant, refer
to "Macros" on page 19.
ECU Type: Type of the ECU, Simulink or DLL
4. Click Add.
The new ECU is added to the Simulink model.
Note: When you use DLL ECUs, INCA-SIP creates the following folders in the
same folder location as the Simulink model.
l

A roof folder named "+<SimulinkModelName>_ DLL".

l

Within the "+<SimulinkModelName>_ DLL" folder, an additional folder
named "+<ECUName>" is created. Please note, that the name of the
ECU must be a valid Simulink package name.

INCA-SIP V7.3 - User's Guide

11

ETAS GmbH

3 Working with INCA-SIP

l

Within the "+<ECUName>" two more folders are created: "+Calibrations"
and "+Measurements".
"+Calibrations" contain search functions which add calibrations.
"+Measurements" contain search functions which add measurements.

DLL ECUs are auto detected if the model does not have any saved configurations. If the model already has some configurations saved, the DLL ECU
can be added manually from the ECUs window.
To configure an ECU in Simulink
1. In the Tools menu, select INCA-SIP→ ECUs.
The "ECUs" dialog box opens.
2. Select the desired ECU.
3. Click Configure in the "ECUs" dialog box.
The "Configure ECU" dialog box opens.
4. Enter your configurations.
For more information, refer to "Configuration description" below.
5. Click Save.

Configuration description
Enabled

If enabled, this ECU will be used. If disabled, INCA-SIP will
skip processing this ECU.

Regenerate
A2L and S19
file

If disabled, INCA-SIP will not generate the A2L and S19 files,
assuming that the content of the existing files is correct. This
can be used to speed the processing time when connecting.
INCA-SIP can decide to ignore this flag if it deems that the
existing files are not using the latest formats, or if any of the
files are missing. In this case, a corresponding information
message will be reported.

ECU Name
(read only)

Name of the ECU. Note that this field is macro compliant. For
more information, refer to "Macros" on page 19.

SIPD File
Name

Path containing the name of the SIPD generated file. The SIPD
file contains a full description of the ECUs events, calibrations,
measurements and groups. Note that this field is macro compliant. For more information, refer to "Macros" on page 19.

AL2 File Name Path containing the name of the A2L generated file. Note that
this field is macro compliant. For more information, refer to
"Macros" on page 19.
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S19 File Name Path containing the name of the S19 generated file. Note that
this field is macro compliant. For more information, refer to
"Macros" on page 19.
XCP TCP Port

The XCP Port on which the ECU XCP Slave service will be
listening on. If set to -1, INCA-SIP will allocate a random port
for this ECU and will save it in the associated configurations.

IPv4 Address

The IPv4 address of the network interface the XCP Slave will
be listing on. If an IP address is configured and such IP is no
longer valid, INCA-SIP will revert the configuration to the Loopback IP (127.0.0.1).

Subsystem
A sub path within the model which this ECU will represent. Pro(visible only in cessing for measurement and calibrations will be limited to
Simulink ECUs) this path and its children. Note that this field is macro compliant. For more information, refer to "Macros" on page 19.
Referenced

Name of the referenced model this ECU represents. If set as

Model (visible

N/A, the ECU represents the root model.

only in Simulink ECUs)
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All/Selection
(visible only in
Referenced
Model Group
ECUs)

All includes all referenced models that exist in the connection

Events

Events can be defined to create rasters in the ECU. The time
unit in the Raster Time column is in milliseconds. If the raster
time is 0, the DAQ will send the data with each solver step in
Simulink. Using raster time 0 can become inefficient if a fixed
solver time is used in Simulink and it is very small.

Search Functions

The two tables contain the search scripts available for that
ECU. They are separated in two tables; one for calibration and
one for measurement. Multiple selection is possible by holding SHIFT pressed down. You can deselect a single item by
holding CTRL pressed down.

phase. The selection allows a subset of the referenced models to be mapped to the ECU, which can be selected using the
Model List function.

Simulink ECUs come with default supported calibration
search scripts for Simulink blocks, these are: Basic Gain,
Basic Lookup 1D, Basic Lookup 2D, Basic Lookup 3D, Table
Lookup nD, Direct Lookups nD, Interpolation Blocks nD,
Prelookups, and Generic S-Function Masked Parameters.
Note that nD implies all dimensions from 1D to 4D.
For measurements, Simulink ECUs support searching for
named lines that are connecting blocks. Each line is followed
to its data source(s). The Runtime Objects of the outports
composing the measurement will then be used for data collection.
DLL ECUs search scripts for these ECUs need to be written
specifically for the custom DLL(s) being calibrated and measured. For more information, refer to chapter "Creating a DLL
Search Script" on page 26 on how to create these custom
scripts.
If the same calibration is in multiple ECUs, calibrating it on
one ECU will not update the dataset of the other ECUs in
INCA. This will result in a checksum error when reinitializing
the hardware from INCA.
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Configuration
If you select this feature, you can configure INCA project creation settings.
To configure INCA project creation settings
1. In the Tools menu, select INCA-SIP→ Configuration.
The "Session Configuration" dialog box opens.
2. Enter your configurations.
For more information, refer to "Session Configuration Description"
below and "Remote INCA Configuration" on the next page.
3. Click OK.

Session Configuration Description
Compile Model

If disabled, when Connect to INCA is pressed, the
Simulink Model is not compiled.
You need compilation to generate measurements,
hence, if a Simulink ECU is using the
BasicNameSiginals Search Script and has the
Compile Model unchecked, it will result in no
measurements being visible in INCA unless the
Regenerate A2L and S19 file is unchecked and
files already exist.

Open INCA On Connect

If enabled, INCA opens and the automatic configuration of the workspace is done.
If disabled, the A2L and S19 files are still generated
(if needed), the XCP slave is initiated, but INCA will
neither be opened nor configured.

INCA Database

The path of the directory INCA should save the
INCA database for INCA-SIP. Note that this field is
macro compliant.For more information, refer to
"Macros" on page 19.

INCA Folder

The name of the INCA folder in the INCA Database. Note that this field is macro compliant. For
more information, refer to "Macros" on page 19.

INCA Workspace

The name of the INCA project Workspace. Note
that this field is macro compliant. For more information, refer to "Macros" on page 19.
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Remote INCA Configuration
Remote INCA Connection

If enabled, INCA-SIP opens INCA on the remote
machine via DCOM.

INCA Machine DNS

The host name or IP address of the remote INCA

Name/IP Address

machine.

Root Network Path

Common UCN path that the INCA machine and
the MATLAB machine can access.

For more information, see "Using INCA Remotely" on page 33.

Note
The default Simulink ECU contains the Emulation Mode Controls in the A2L.
For more information, refer to "INCA-SIP Emulation Mode" on page 20.
If Show Workspace/DD Variables is enabled, each ECU will have a new group
in the Variable Selection Dialog. The new group contains all the variables used
by the model which are either in the global workspace, in the local workspace or
in the data dictionary.

3.3.4

MDF Configuration
If you select this feature, you can configure the MDF stimulus.
To configure INCA the MDF stimulus
1. In the Tools menu, select INCA-SIP → MDF Configuration.
The "MDF Configuration" dialog box opens.
2. Enter your configurations.
For more information, refer to "MDF Configuration Description" on
the next page.
3. Click OK.
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MDF Configuration Description
Use MDF Stimulus

If enabled, INCA-SIP will allow loading external
stimulus from MDF files to inputs in Simulink.
Once connected INCA-SIP will validate that the
stimuli are loaded.

Stimulus File

The MDF file from which the stimuli will be loaded
and mapped. Note that this field is macro compliant. For more information, refer to "Macros" on
page 19.

Mapping File

The configuration file defining the Mapping MDF
signals from the Stimulus file to the inputs in the
Simulink Model. If the file does not exist INCA-SIP
will generate it automatically when the mapping
tool is used. Note that this field is macro compliant.For more information, refer to "Macros" on
page 19.

Mapping Tool

Opens the MDF Mapping tool. This tool will allow
to map MDF signal to inputs in the Simulink
Model. The left hand side tree shows the ports in
Simulink to which data can be coupled with. The
right hand side table contains all the data from the
MDF file. The MDF data can be dragged onto the
Mapping Value column to map the data of that
column to the required inport.
INCA-SIP loads the data for the selected MDF
stimuli from time = 0 till time = <simulation time>.
If the simulation time is extended the mapping
tool needs to be re-used to load the data to the
newly specified simulation time.
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Using the MDF Mapping Dialog

To map a signal
l

In the "MDF Mapping Tool" window, drag the desired MDF signal
and drop it on a Simulink port.
The Simulink ports can be identified by the following icon:

or
1. Select a Simulink port.
2. Double-click on the desired MDF signal to map it to the port.

Clearing MDF Mappings
To clear all mappings
l

In the "MDF Mapping Tool" window, select Tools → Clear All Mappings.

or
l

Right-click on the Simulink port tree and select Clear All
Mappings.

To clear individual mappings
1. Select a port or a tree node.
2. Press the <DEL> key.
or
l

Right-click on the Simulink tree and select Clear Selected.
The selected node and all of its children are cleared.
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Note
This operation cannot be performed on the root node.

Updating the Simulink Ports
To map MDF signals to Simulink ports, the model must be compiled. INCA-SIP
uses the last known configuration (if available) to avoid recompiling the model
every time the mapping tool is opened. This last known configuration may be outdated.
To update the Simulink port tree
1. In the "MDF Mapping Tool" window, click on Tools.
2. Reload Simulink ports from the "Mapping" dialog.

Updating MDF Signal Data
For performance reasons, the MDF data is stored as part of the model workspace. This data may be out of date, so manual updating is necessary. For
example, if the MDF file is changed or replaced with the same MDF file name
and path.
To update the MDF signals
1. In the "MDF Mapping Tool" window, click on Tools.
2. Reload MDF data from the "Mapping" dialog.

Note
There are cases where the data is automatically reloaded when connecting to
INCA:
l

If INCA loads the MDF data, the simulation time is taken into account and
only the required amount of data is loaded. If the simulation time is
changed to a longer duration, the data is automatically reloaded.

l

If the MDF path is changed in the MDF configuration window, the cached
MDF data is deleted so that it is automatically reloaded when connecting.

l

If a Simulink port is changed and the assignment becomes invalid, the
MDF data for that port is deleted and automatically reloaded (if reassigned)
when connecting.

3.4

Macros
INCA-SIP supports macro variables in strings to provide you dynamic strings.
You can perform the following macro variables:
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l

$(SystemName): Resolves to the name of the model.

l

$(ECUName): Resolves to the name of the ECU (can only be used in
ECUs Configuration window).

l

$(INCADataDir): Resolves to the INCA data directory path.

l

$(INCASIPDir): Resolves to INCA-SIP Installation path.

INCA-SIP also supports environment variables in macros, e.g. %(APPDATA)%.

3.5

Naming Conventions

3.5.1

Calibrations and Measurements
When INCA-SIP processes an ECU, it will generate an A2L file. Hence any
names for measurements and calibrations need to be compliant with the A2L
calibrations and measurement names. Non-compliant names are renamed
accordingly. In addition, if there are any name conflicts, INCA-SIP adds _x to the
name, where x is an integer in the range 1 to infinity.

3.5.2

Groups
You can define measurements and calibrations to exist in Groups, shown in
INCA's Variable Selection Dialog (VSD). If there are any name conflicts between
group names in the same ECU, INCA-SIP will add _x to the name, where x is an
integer in the range 1 to infinity.

The "ETAS_SIP" Group will contain the controls related to the INCA-SIP Emulation Mode.

3.6

INCA-SIP Emulation Mode
INCA-SIP provides two modes of model simulation:
l

"Real-Time Emulation Mode"

l

"Fast Emulation Mode"

These controls are available in the "Default Simulink ECU" in the A2L file in the
"ETAS-SIP" group.
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Real-Time Emulation Mode
In Real-Time Emulation Mode, the INCA-SIP add-on attempts to approximate
real-time simulation. Therefore, if the model is simulating faster than real-time
use-case, INCA-SIP will throttle the model simulation to near real-time. On the
other hand, INCA-SIP has no effect on model simulation when it is simulating
slower than real-time.
This mode is ideal in the case the user would like to calibrate the model during
simulation and visualize the effects of the calibration on the simulation.
To activate this mode of operation, within the associated INCA experiment, you
need to add the RealTimeBlock.mode calibration and select the "Real Time"
option. The Calibration RealTimeBlock.realTimeMultiplier calibration
can be used to change the throttling multiplier as described below:
Equal to 1

Represents real time

Less than 1

Represents slower than real time

Greater than 1

Represents faster than real time

Less than or equal to 0

Are equivalent to INF, which represents the Fast
Emulation Mode

You can find these calibrations in the "ETAS_SIP" group in the "Default Simulink
ECU".

3.6.2

Fast Emulation Mode
In Fast Emulation Mode, during model simulation, the INCA-SIP add-on transmits data to INCA as fast as possible, while ensuring no data loss.
Therefore, this behavior makes it impractical for data visualization. This mode is
ideal in case you would like to make offline calibration changes and then simulate the model for a fixed period of time. This model simulation should be complete in a relatively short period of time, while the measured data can then be
analyzed offline through MDA (Measure Data Analyzer).
In order to activate this mode of operation, within the associated INCA experiment, you need to add the RealTimeBlock.mode calibration and select the
"Fast Emulation" option. You can find these calibrations in the "ETAS_SIP" group
in the "Default Simulink ECU".

3.7

INCA-SIP and Block Reduction
MATLAB supports block reduction by default. The calibrations and measurements can be optimized or eliminated from the simulation if these are
deemed to have no effect on the simulation. INCA-SIP ignores such calibrations
and measurements. You can enable and disable block reduction from the simulation settings. For more information, refer to the MATLAB documentation.
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Simulation Modes
MATLAB provides various simulation modes. INCA-SIP supports the following
modes:
l

Normal Mode

l

Accelerated Mode

l

Rapid Accelerated Mode

Note
Rapid Accelerator Mode needs a working registered C++ compiler to work. For
more information, refer to "Registering a C++ Compiler" on page 7.

Note
Due to changes in new MATLAB versions, Rapid Accelerator mode is only supported on MATLAB version 2018b and below.

3.9

Referenced Models Support
Referenced models are normal models in Simulink. These models are referenced by a parent model, allowing the parent model to link to the referenced
model’s inputs and outputs. When configuring an ECU, it can be configured to
point to a specific referenced model by choosing the referenced models name
from the combo box.
Referenced models are shown as a separate ECU in INCA.

3.10

Refusing Calibrations
There can be cases where MATLAB Simulink refuses calibrations sent by INCA.
One such example is when you use a workspace variable as table data and axis
data at the same time. In such case, the axis data need to be increasing monotonically while the table data has no such restrictions. If the table data is calibrated and monotonicity is broken, MATLAB will refuse this calibration. The
error code CALMEM_REQUESTNOTVALID being returned by XCP is displayed in
the INCA Monitor window.

3.11

Busy ECU
Some requests may be time consuming and will place the ECU in a busy state.
One such example is when calibrating a large array at one go by doing increment/decrement on all elements together. In such case, the ECU is busy with
this request execution and INCA will show a dialog until the ECU is free again
and is able to receive the next command.
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Starting and Stopping the Experiment
To start the experiment
1. In the INCA Experiment window, click

or press F11.

The simulation in Simulink behaves as follows:
Start if the simulation was in a stopped state.
or
Continue if simulation was in a paused state.
To stop the experiment
1. In the INCA Experiment window click stop

or press F9.

The simulation in Simulink behaves as follows:
Pause in Normal and Accelerated Mode.
or
Stop in Rapid Accelerate Mode.

Note
The simulation state is changed in the above cases only if there are some
measurements selected in the INCA experiment.

3.13

Simulink.Signal and Asap2.Signal Support
In Simulink ECUs, if a named line is named after a Simulink.Signal or Asap2.Signal, the measurement will take the "Description", "Unit", "Min" and "Max" from
the Simulink.Signal or Asap2.Signal variable.

3.14

Simulink.Parameter and Asap2.Parameter Support
In Simulink ECUs, if a supported block has a parameter with the content of a
workspace variable of type Simulink.Parameter or Asap2.Parameter, the calibration will take the "Description", "Unit", "Min" and "Max" from the Simulink.Parameter or Asap2.Parameter variable.

3.15

Error, Warning and Information Messages
INCA-SIP displays error, warning and information messages during the connection and simulation process.
Messages related to an open Simulink model are logged in the Simulink’s Diagnostic Viewer.
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To open Simulink’s Diagnostic Viewer
1. In the Simulink editor, click View → Diagnostic Viewer.
MATLAB also opens the Diagnostic Viewer whenever an error message is logged.

3.16

DLL Mode
In MATLAB, you can write an S-function which internally uses DLLs at some
stage of its processing. The INCA-SIP DLL mode provides support to calibrate
and measure global variables within a DLL.
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Creating the DLL
You can find a sample Visual Studio Project under
<drive>:\ETASData\INCA7.3\Demo\AddOn_ INCASIP7.3\SIPDllDemo.
The contents of the "SIPDllDemo" folder is described below.
"legacy_alg"

Contains the sample DLL which we will be calibrating and
measuring from INCA. When the solution is built, it will copy
the DLL and the map file to the "x64" folder. The map file is
used to determine the module and variables offset.

"x64"

Used in a 64-bit MATLAB version, this folder contains the
model and the DLL search scripts. To use this project, the
legacy_alg_sfcn.c file needs to be compiled using mex
legacy_alg_sfcn.c.

In the source code there are a number of global variables which can be measured or calibrated.

Note
No synchronization mechanisms are in place between SIP and the DLL. Therefore, race conditions can occur if INCA-SIP is not the only actor calibrating the
variables.
INCA-SIP supports the following types for DLL Mode:
INCA-SIP DLL Type

C Type

Size

MScripts.DllMode.

uint8_t

8

uint16_t

16

uint32_t

32

uint64_t

64

int8_t

8

int16_t

16

Remarks

DllAsap2Object.UINT8
MScripts.DllMode.
DllAsap2Object.UINT16
MScripts.DllMode.
DllAsap2Object.UINT32
MScripts.DllMode.

Calibrations Only

DllAsap2Object.UINT64
MScripts.DllMode.
DllAsap2Object.INT8
MScripts.DllMode.
DllAsap2Object.INT16
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INCA-SIP DLL Type

C Type

Size

Remarks

MScripts.DllMode.

int32_t

32

int64_t

64

uint8

8

float

32

IEEE-754

double

64

IEEE-754

DllAsap2Object.INT32
MScripts.DllMode.
DllAsap2Object.INT64
MScripts.DllMode.
DllAsap2Object.BOOL
MScripts.DllMode.
DllAsap2Object.FLOAT
MScripts.DllMode.
DllAsap2Object.DOUBLE

Note
int64 and uint64 will only work with calibrations. If used in measurements,
these will be seen in INCA and in the Variable Selection Dialog but cannot be
selected.

3.16.2

Creating a DLL Search Script
You can find sample scripts under
<drive>:\ETASData\INCA7.3\Demo\AddOn_ INCASIP7.3\SIPDLLDemo\x64\+SipDllDemo_DLL\+DllDemo
Each search script is defined by having a function defined by the following function signature:
<Function Name>(dataModel, sRootSystem)
The "dataModel" is the object to which calibrations and measurements need to
be added. "sRootSystem" is a string with the name of the model.

DataModel Function Calls
Function

addCalibration (calibration)

Parameters calibration

Calibration Description Object

Return Value None
Description Adds this Calibration Description Object to the data model to be
shown in INCA. All axis associated to the calibration will be
added automatically
Function

addCalibrationAxis (axis)
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Parameters axis

Calibration Axis Description
Object

Return Value None
Description Adds this Calibration Axis Object to the data model to be shown
in INCA. This should only be used if you intend to show a standalone calibration axis which was not associated to any Calibration Object.

Function

addMeasurement (measurement)

Parameters

measurement

Measurement Description
Object

Return Value None
Description

Adds this Measurement Description Object to the data model to
be shown in INCA.

Once you have defined a DLL calibration and have set all its properties, you need
to add it to the data model. You can achieve this by:
dataModel.addCalibration(calibration);

Note
An axis object should only be linked to one calibration. Should you want to link
the same module offset to another calibration as an axis, another instance of
the axis should be created.
If the calibration had a linked axis to it, you do not need to add the axis since
these will be added automatically.
If an axis is not linked to any calibration, you can add it by:
dataModel.addCalibrationAxis(axis);
Once you have defined a DLL measurement and have set all its properties, you
need to add it to the data model. You can achieve this by:
dataModel.addMeasurement(measurement);
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Creating Object Using DllAsap2ObjectFactory
Creating Calibrations
The MScripts.DllMode.DllAsap2ObjectFactory provides the following methods to create calibrations:
Function

createScalarCalibration(name, moduleOffset,
cDataType, dllName, groupPath)

Parameters name

Name as it will be shown in INCA

moduleOffset

Module offset address hex string
of the varable in the DLL

cDataType

Type of the data at the module
offset

dllName

The name of the DLL where the
module offset is located

groupPath

Group in which the calibration will
be shown in INCA

Return Value Calibration Description Object
Description Creates a Scalar calibration which is visualized as a simple calibration in INCA

Function

createTableCalibration(name, moduleOffset,
cDataType, dllName, groupPath)

Parameters name

Name as it will be shown in INCA

moduleOffset

Module offset address hex string
of the variable in the DLL

cDataType

Type of the data at the module
offset

dllName

The name of the DLL where the
module offset is located

groupPath

Group in which the calibration will
be shown in INCA

arraySize

The size of the array in vector
format (e.g. [1 3] or [2 3 4])

Return Value Calibration Description Object
Description

Creates a n-dimensional calibration which is visualized as a calibration in INCA
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Function

createFixedAxis(offset, distance, numberOfAxisPoints, asap2Description)
Start value of the Fixed Axis

Parameters offset
distance

Increment Size

numerOfAxisPoints

Number of elements in the
axis

Return Value Fixed Axis Description Object
Description Creates fixed axis. This can only be linked to a n-dimension calibration. Note All n-dimension calibrations have assigned to them
a fixed axis by default

Function

createCalibrationAxis(name, moduleOffset,
cDataType, dllName, groupPath, arraySize)

Parameters name

Name as it will be shown in
INCA

moduleOffset

Module offset address hex
string of the variable in the DLL

cDataType

Type of the data at the module
offset

dllName

The name of the DLL where the
module offset is located

groupPath

Group in which the calibration
will be shown in INCA

arraySize

The size of the array in vector
format (e.g. [1 3] or [2 3 4])

Return Value Calibration Axis Description Object
Description Creates an axis. This can be linked to a n-dimension calibration
or added as a to the data model without being linked to a Table
Calibration
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Function

createCalibrationAxisWithMeasurementKey(name,
moduleOffset, cDataType, dllName, groupPath,
arraySize, sMeasurmentKey, hDataModel)
Name as it will be shown in
INCA

Parameters name

Return

moduleOffset

Module offset address hex
string of the variable in the DLL

cDataType

Type of the data at the module
offset

dllName

The name of the DLL where the
module offset is located

groupPath

Group in which the calibration
will be shown in INCA

arraySize

The size of the array in vector
format (e.g. [1 3] or [2 3 4])

sMeasurmentKey

The Measurement Key of the
measurement which relates to
this axis

hDataModel

Handle to the data Model

Calibration Axis Description Object

Value
Description Creates an axis. This can be linked to a n-dimension calibration or
added as a to the data model without being linked to a Table Calibration

Note
It is the responsibility of the user to ensure that the module offset and the
array sizes are correct.

Linking an Axis to a Calibration
If you would like to link a DLL Axis Calibration to a DLL Table Calibration, you can do the following on Calibration Description Objects:
Function

setAxis (axis, index)

Parameters

axis

Calibration Axis Description Object

index

Index of axis e.g. 1=X axis, 2=Y axis, 3=Z
axis, 4=W axis

Return Value None
Description

Associates an axis to Calibration Description Object
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Creating Measurements
The MScripts.DllMode.DllAsap2ObjectFactory provides the following methods to create measurements:
Function

createScalarMeasurement(name, moduleOffset,
cDataType, dllName, groupPath, arraySize)

Parameters name

Name as it will be shown in
INCA

moduleOffset

Module offset address hex
string of the variable in the DLL

cDataType

Type of the data at the module
offset

dllName

The name of the DLL where the
module offset is located

groupPath

Group in which the calibration
will be shown in INCA

Return Value Measurement Description Object
Description Creates a Scalar measurement which is visualized as a simple
measurement in INCA

Function

createArrayMeasurement(name, moduleOffset,
cDataType, dllName, groupPath, arraySize)

Parameters name

Name as it will be shown in
INCA

moduleOffset

Module offset address hex
string of the variable in the DLL

cDataType

Type of the data at the module
offset

dllName

The name of the DLL where the
module offset is located

groupPath

Group in which the calibration
will be shown in INCA

arraySize

The size of the array in vector
format (e.g. [1 3] or [2 3 4])

Return Value Measurement Description Object
Description

Creates a n-dimensions measurement which is visualized as a
collection of simple measurements in INCA
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Note
The name must follow ASAP2 naming conventions. If it is not adhered to,
INCA-SIP renames the measurement/calibration to make it compliant. Similarly, if the same name has already been used in the ECU, then _x will be
appended to the name, where x is an auto-incrementing integer ranging from 1
to infinity.

Note
It is the responsibility of the user to ensure that the module offset and the
array sizes are correct.

General Options
All objects can have a description, minimum and maximum values set using the
function calls below.
Function

setAsap2Description (sDescriptionText)

Parameters

sDescriptionText

Return Value

None

Description

Set description for object

Function

setAsap2MinValue (dMin)

Parameters

dMin

Return Value

None

Description

Sets minimum allowed value

Function

set2AsapMaxValue (dMax)

Parameters

dMax

Return Value

None

Description

Sets maximum allowed value

INCA-SIP V7.3 - User's Guide

Description Text

Minimum Value

Maximum Value

32

ETAS GmbH

3.17

3 Working with INCA-SIP

Function

addGroupPath(sGroupPath)

Parameters

sGroupPath

Return Value

None

Description

Adds another group path where the object is to be seen in INCA

Group in which the calibration will be
shown in INCA

Using INCA Remotely
Remote INCA access is required if you want to use one machine to operate a
Simulink model while using INCA on another machine to calibrate the Simulink
model.
To run INCA remotely, INCA-SIP and INCA must be installed on the INCA
machine and the remote machine.

Setting up the Remote INCA Connection
To set up the Remote INCA Connection, perform the follwing actions:
l

"To adjust the Window Component Services settings " below

l

"To add an user or a group to the INCA DCOM Config" below

l

"To adjust the INCA-SIP settings in MATLAB" on the next page

To adjust the Window Component Services settings
1. Open the Windows desktop app Component Services.
2. Expand all Component Services folders.
3. Right-click on My Computer and select Properties.
4. In the Default Properties tab, make the following settings:
Enable Enable Distributed COM on this computer.
Set the Default Authentication Level to Connect.
Set the Default Impersonation Level to Identify.
5. Click Apply.
6. Click OK.
To add an user or a group to the INCA DCOM Config
1. Open the Windows desktop app Component Services.
2. Expand all Component Services folders.
3. In the DCOM Config folder, right-click on INCA72 Server and
select Properties.
4. Select the Security tab.
5. In the Launch and Activation Permissions list, enable Customize.
6. Click Edit.
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7. In the Group or user names list, click Add and add a new user or a
new group.
8. Click OK.
9. In the Permissions for SYSTEM list, enable all Allow check
boxes.
10. Click OK.
11. Click Apply.
12. Click OK.
If you add an user or a group, ensure that:
l

The added user is the same user who is using MATLAB.

l

The added group contains the user who is using MATLAB.

To allow DCOM communication through the firewall, you may need to change
the firewall settings. For more information, refer to the Microsoft documentation.
To adjust the INCA-SIP settings in MATLAB
1. In the Tools menu, select INCA-SIP → Configurations.
2. Enable the following settings:
Open INCA On Connect
Remote INCA Connection
3. In the INCA Machine DNS Name/IP Address field, enter the host
name or the the IP address of the INCA remote machine.
4. In the Root Network Path field, enter a common UCN path that the
INCA machine and the MATLAB machine can access.
The Root Network Path is used to save the INCA database, the
A2L file, and the S19 file. The data will be saved in the remote network path if the configured path is relative. In such case, the path
is resolved relative to the configured UCN path. If the path is absolute, then it is the responsibility of the user to make sure that the
INCA database path is accessible by the remote INCA machine.
The A2L and S19 path will be accessible by both machines using
the same UCN.
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Note
Each ECU has its own TCP Port. Note that each ECU port must be allowed as
an incoming port on the MATLAB machine by the firewall. In addition, each
ECU has the IP Address which INCA will use to connect to the XCP Slave. If
the selected address is not on the same subnet as the INCA machine, INCASIP attempts to find an interface which is on the same subnet as the INCA
machine. If no such interface is found, manual user action will be needed to
identify the appropriate IP Address.

3.18

Custom Hooks
INCA-SIP provides hooks to allow:
l

Custom filtering

l

Custom measurement and calibration naming

l

Custom group naming

l

Customization of variables

Some use cases of these hooks are:
l

Filter unwanted calibrations and measurements

l

Create custom own naming conversion for calibrations, measurements,
and groups

l

Set the display identifier etc..

Custom hooks are function pointers to MATLAB functions.
The hooks can be set in the MScripts.Configuration by calling:
l

"setVariableFilterFunctionHandle" on the next page

l

"setVariableCustomizationFunctionHandle" on page 37

l

"setVariableRenamingFunctionHandle" on page 39

l

"setGroupRenamingFunctionHandle" on page 40

The hooks can be reset in the MScripts.Configuration by calling:
l

clearGroupRenamingFunctionHandle

l

clearVariableCustomisationFunctionHandle

l

clearVariableFilterFunctionHandle

l

clearVariableRenamingFunctionHandle

The MScripts.Configuration class is a singleton and is global to the
MATLAB Instance.
To get the instance of this class
1. Execute MScripts.Configuration.getInstance().
Any changes done to the configuration class are lost when MATLAB is closed.
Therefore, custom hooks would need to be set every time MATLAB is opened.

INCA-SIP V7.3 - User's Guide

35

ETAS GmbH

3.18.1

3 Working with INCA-SIP

setVariableFilterFunctionHandle
Each calibration or measurement added to a data model is passed to the custom hook if it is set. If the custom function accepts this calibration, it is added to
the data model otherwise it is skipped and none of the remaining custom hooks
are called with regards to this calibration or measurement.

Hook Function Signature

tion

bKeep = variableCustomFilter(type, variableInfoWrapper)

Para-

bkeep returns

Func-

meters

true
false
type char[]

If the calibration or measurement is to be kept.
If the calibration or measurement is to be filtered
out.
Can be one of the following constants:
MScripts.DataModelBase.SimulinkdWorkspaceCalibration
MScripts.DataModelBase.DLLCalibrationAxis
MScripts.DataModelBase.DLLCalibration
MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement

variableInfoWrapper
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Note
During this hook, only getters should be used on the variableInfoWrapper. Any changes needed to be effected to this calibration or
measurement can be effected in the setVariableCustomisationFunctionHandle hook.
For an example of this hook, see the CustomHooks variableCustomFilter.m script located in the "SIPDEMO" folder.
Variable selection before using a custom hook

Variable selection after using a custom hook

3.18.2

setVariableCustomizationFunctionHandle
Each calibration or measurement that pass the filter function stage can be customized in this custom hook. To better understand what can be customized
refer to "MScripts.VariableWrapper" on page 42.
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Hook Function Signature
Func-

variableCustomization(type, variableInfoWrapper)

tion
Para-

type char[]

meters

Can be one of the following constants:
MScripts.DataModelBase.SimulinkWorkspaceCalibration
MScripts.DataModelBase.DLLCalibrationAxis
MScripts.DataModelBase.DLLCalibration
MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement

variableInfoWrapper

Instance of MScripts.VariableWrapper.
The variableInfoWrapper is used to determine which calibration or measurement is currently
being processed. For more information on how to
use the variableInfoWrapper, refer to
"MScripts.VariableWrapper" on page 42.

For an example of this hook, see the CustomHooks variableCustomization.m script located in the "SIPDEMO" folder.
Variable selection before using a custom hook

Variable selection after using a custom hook
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setVariableRenamingFunctionHandle
Calibration or measurement that pass the filter function stage can be renamed
in this custom hook. Calibrations added due to the show workspace/data
dictionaries variables are not passed to this hook as these cannot be
renamed.

Hook Function Signature
Function mappedName = variableNameMapper(incaSIPName,
type, variableInfoWrapper)

Parameters

mappedName

New desired mapped name. Cannot be empty.

incaSIPName

Suggested name from INCA-SIP

type char[]

Can be one of the following constants:
MScripts.DataModelBase.DLLCalibrationAxis
MScripts.DataModelBase.DLLCalibration
MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement

variableInfoWrapper
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Note
l

If the mapped name is not ASAP2 compliant INCA-SIP
will correct this to make it compliant.

l

If the mapped name is already used, INCA-SIP will
append _x where x is 1 to inf.

l

The incaSIPName is the suggested name and It can also
be non-unique and/or non ASAP2 compliant at this stage

l

During this hook only getters should be used on the variableInfoWrapper. Any changes needed to be effected to
this calibration or measurement can be effected in the
setVariableCustomisationFunctionHandle hook.

For an example of this hook, see the CustomHooks variableNameMapper.m script located in the "SIPDEMO" folder.
Variable selection before using a custom hook

Variable selection after using a custom hook

3.18.4

setGroupRenamingFunctionHandle
Each group path for all the calibration or measurement that pass the filter function stage can be renamed in this custom hook. Each unique path will only be
passed to the hook once.
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Hook Function Signature
Function

mappedName = groupNameMapper(incaSIPName,
type, metadata)

Para-

mappedName New desired mapped name. Cannot be empty.

meters

incaSIPNam- Suggested name from INCA-SIP.
e
type char
[]

Can be one of the following constants:
MScripts.DataModelBase.SimulinkGroup
MScripts.DataModelBase.DLLGroup

metadata

Full path of the group, e.g. /model/subsystem/subsubsystem. The
metadatais used to determine the group that is
currently being processed.

Note
l

If the mapped name is not ASAP2 compliant INCA-SIP
will correct this to make it compliant.

l

If the mapped name is already used INCA-SIP will append
_x where x is 1 to inf.

l

The incaSIPName is the suggested name and it can also
be non-unique or non ASAP2 compliant at this stage

For an example of this hook, see the CustomHooks groupNameMapper.m
script located in the "SIPDEMO" folder.
Variable selection before using a custom hook

Variable selection after using a custom hook
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MScripts.VariableWrapper
This class is used to wrap calibration and measurements and to allow access
for changing specific aspects of its properties.

Properties and functions that can be changed
Property

sDisplayIdentifier

Descrip-

A2L Display Identifier Entry

tion
Usage

MScripts.DataModelBase.DLLCalibration

with Vari-

MScripts.DataModelBase.DLLMeasurement

able Types
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.SimulinkWorkspaceCalibration
Field Type char[]

Property

dMin

Descrip-

A2L variable minimum valued allowed. Used by INCA.

tion
Usage
with Variable Types

MScripts.DataModelBase.DLLCalibrationAxis
MScripts.DataModelBase.DLLCalibration
MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
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MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.SimulinkWorkspaceCalibration
Field Type number

Property

dMax

Descrip-

A2L variable maximum valued allowed. Used by INCA.

tion
Usage

MScripts.DataModelBase.DLLCalibrationAxis

with Vari-

MScripts.DataModelBase.DLLCalibration

able Types

MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.SimulinkWorkspaceCalibration

Field Type number

Property

sDescription

Descrip-

AL2 variable description entry.

tion
Usage

MScripts.DataModelBase.DLLCalibrationAxis

with Vari-

MScripts.DataModelBase.DLLCalibration

able Types

MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.SimulinkWorkspaceCalibration

Field Type char[]
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Property

numOfDimensions

Descrip-

Number of dimension of the data the variable represents.

tion
Usage

MScripts.DataModelBase.DLLCalibrationAxis

with Vari-

MScripts.DataModelBase.DLLCalibration

able Types

MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.SimulinkWorkspaceCalibration

Field Type number

Property

dataAccessInfo

Description

Used to determine which calibration or measurement this variable
wrapper represents.

Usage

MScripts.DataModelBase.DLLCalibrationAxis

with Vari-

MScripts.DataModelBase.DLLCalibration

able Types

MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.SimulinkWorkspaceCalibration

Field Type MScripts.AccessInfo
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Function

addGroupPath(<char[] newPath>)

Descrip-

Adds another A2L group to this variable.

tion
Usage

MScripts.DataModelBase.DLLCalibrationAxis

with Vari-

MScripts.DataModelBase.DLLCalibration

able Types

MScripts.DataModelBase.DLLMeasurement
MScripts.DataModelBase.SimulinkCalibrationAxis
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkMeasurement
MScripts.DataModelBase.SimulinkWorkspaceCalibration

Field Type MScripts.AccessInfo
Parameter

New A2L group in which this variable is to be shown.
newPath This path does not need to exists in the Simulink model.
It can be any path.

Function

makeComAxis

Description Forces axis to be a COM axis in the A2L.
Usage with MScripts.DataModelBase.DLLCalibrationAxis
Variable

MScripts.DataModelBase.SimulinkCalibrationAxis

Types
Field Type

MScripts.AccessInfo

Property

xAxisAccessInfo

Descrip-

Used to determine which calibration axis this variable element represents.

tion
Usage
with Vari-

Can be used with the following variable types if numOfDimensions >= 1:

able Types MScripts.DataModelBase.DLLCalibration
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkWorkspaceCalibration
Field Type MScripts.AccessInfo

INCA-SIP V7.3 - User's Guide

45

ETAS GmbH

3 Working with INCA-SIP

Property

yAxisAccessInfo

Descrip-

Used to determine which calibration axis this variable element represents.

tion
Usage
with Vari-

Can be used with the following variable types if numOfDimensions >= 2:

able Types MScripts.DataModelBase.DLLCalibration
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkWorkspaceCalibration
Field Type MScripts.AccessInfo

Property

zAxisAccessInfo

Descrip-

Used to determine which calibration axis this variable element represents.

tion
Usage
with Vari-

Can be used with the following variable types if numOfDimensions >= 3:

able Types MScripts.DataModelBase.DLLCalibration
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkWorkspaceCalibration
Field Type MScripts.AccessInfo

Property

wAxisAccessInfo

Descrip-

Used to determine which calibration axis this variable element represents.

tion
Usage
with Vari-

Can be used with the following variable types if numOfDimensions = 4:

able Types MScripts.DataModelBase.DLLCalibration
MScripts.DataModelBase.SimulinkCalibration
MScripts.DataModelBase.SimulinkWorkspaceCalibration
Field Type MScripts.AccessInfo
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Note
For all axisAccessInfo an exception can also be thrown if the axis in that
index is a non-editable axis (Fixed Axis).

l

If calls are used on the wrong variable types, exceptions will be thrown.

l

MScripts.AccessInfo is used to determine which calibration or
measurement this variable wrapper represents.

3.18.6

MScripts.AccessInfo
This class contains two parameters that are enough to determine which calibration or measurement is being represented. These parameters are
accessParameter1 and accessParameter2. For better description, one
can make use of more meaningfull getters depending on the variable type.
If Vari-

MScripts.DataModelBase.SimulinkCalibrationAxis

able
Type is
Use

MScripts.DataModelBase.SimulinkCalibration
getBlockPath

getPropertyName
Note

The Block path is the path in the model where
the block is located.
The property name is the property in the block
this calibration is representing.

Helper Function to get the name of the block using the access info:
blockName = MScripts.AccessInfo.getBlockName(<hAccessInfo>);

If Vari- MScripts.DataModelBase.SimulinkWorkspaceCalibration
able
Type is
Use

getBlockPath
getPropertyName
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If Vari-

MScripts.DataModelBase.SimulinkMeasurement

able
Type is
Use

getBlockPath

getPortNumber
Note

The Block path is the path in the model where
the block is located.
The port number is the index of the line with
respect to the outports of the block.

Helper Function to get the name of the block using the access info:
LineName = MScripts.AccessInfo.getLineName (<hAccessInfo>);

If Vari-

MScripts.DataModelBase.DLLCalibrationAxis

able

MScripts.DataModelBase.DLLCalibration

Type is
Use

MScripts.DataModelBase.DLLMeasurement
getDllName

The DLL name is the name of the DLL being
used in DLL mode.
The module offset is the memory offset where

getModuleOffset the variable is located in the DLL. For more
information, refer to "DLL Mode" on page 24.

3.19

Supported Simulink Block Types
INCA-SIP supports the following Simulink block types:
Block Type

Constant

Block Type

Gain

Block Type

Lookup

Block Type

Lookup2D

Block Type

Lookup3D

Block Type

sfun_lookupnd

Block Type

Stateflow

Prerequisites

Parameters - Workspace Variables

Block Type

LookupNDDirect

Prerequisites

NumberofTableDimensions → 1-4
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Block Type

S-Function & M-S-Function

Prerequisites

Tunable → on
Visible → on
Enabled → on
ReadOnly → off

Block Type

Interpolation_n-D & S-Function (FunctionName → sfun_
kflookupnd)

Prerequisites

TableSource → Dialog
NumberOfTableDimensions/numDimsPopupSelect →
1-4

Block Type

ManualSwitch

Block Type

PreLookup D & S-Function (FunctionName → sfun_idxsearch)

Block Type

Lookup_n-D

Prerequisites

NumberofTableDimensions → 1-4
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Restrictions and Other Behaviors
This section contains a range of tips and information on restrictions and behaviors of INCA-SIP.

3.20.1

RAM Calibration
RAM calibration is not supported in INCA-SIP. RAM calibration allows calibration
of measurements. You can enable or disable this in the INCA user options. Such
calibrations are represented in the Variable Selection Dialog as shown in the
image below.

3.20.2

Parallel Measurements with Other Hardware
When you use INCA-SIP, it is not supported to measure and calibrate with other
devices in INCA.

3.20.3

Pausing Measurements
If you use the "Pause Recording" function in INCA, you may notice in the subsequent measure data analysis in MDA that there is no data or data has been
interpolated over extended areas.
This behavior deviates from that of measure physical hardware in which a
paused measurement in the measure file is displayed in the form of breaks of
1s.
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Tutorial
This tutorial presents a simple example in order to show how to operate INCASIP. You find the "SIPDemo" model in the following directory:
<drive>:\ETASDATA\INCA7.3\Demo\AddOn_ INCA-SIP7.3.
In this tutorial, you connect a Simulink model to INCA, run the experiment and
make changes to the Simulink model.
You can perform the following steps:
l

"To add INCA-SIP to MATLAB" below

l

"To connect INCA-SIP to INCA" below

l

"To calibrate and measure the model in INCA" below

l

"To change the emulation mode" on the next page

To add INCA-SIP to MATLAB
If you use your MATLAB version with INCA-SIP for the first time, then add INCASIP to the MATLAB path. For more information, refer to "Installation Path of
INCA-SIP" on page 8.
1. Open MATLAB
2. Navigate to the "SIPDEMO" folder.
3. To open the Simulink model, double-click sipdemo.mdl.
The Simulink editor opens and displays the model.
To connect INCA-SIP to INCA
1. In the MATLAB Tools menu, select INCA-SIP → Connect to
INCA.
A "ETAS SIP" block is added to the model. INCA is started and a
folder within the "INCASIP" database, a workspace and an ECU project are created.
To calibrate and measure the model in INCA
1. In the INCA "Database Objects" window area, open the folder
INCASIP/sipdemo.
2. Double-click on the workspace

"sipdemo_wsp".

The INCA experiment environment opens.
3. Select Variables → Variable Selection
or
click

or press SHIFT + F4.

The Variable Selection Dialog (VSD) opens.
4. Select the variable "SineWaveOutput".
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5. Right-click on the variable and select Add to... → Layer_1 →
New... → YT-Oscilloscope.
6. Select the variable "SineWaveAmplitude".
7. Click OK.
The calibration and measurement variables are added to a new YT
oscilloscope.
8. To start the experiment, click

or press F11.

The simulation in Simulink and the measurement in INCA is started and displayed in the YT-oscilloscope.
9. To stop the experiment, click

or press F9.

Note
If you change the "SineWaveAmplitude" values in the INCA experiment, the
oscilloscope reflects these changes.
To change the emulation mode
1. In the INCA experiment environment, select Variables → Variable
Selection or click

or press SHIFT + F4.

The Variable Selection Dialog (VSD) opens.
2. Select the calibration variable "RealTimeBlock.mode" and
"RealTimeBlock.realTimeMultiplier".
The default editor for the scalar variable opens. You can select t a
default editor via the INCA user options.
3. Change the value of the "RealTimeBlock.realTimeMultiplier" variable to 4.
The simulation runs four times faster than real time.
or
Change the "RealTimeBlock.realTimeMultiplier" variable to 0.5.
The simulation runs slower than real time.
or
Change the "RealTimeBlock.mode" variable to Fast Emulation
Mode.
The simulation runs at its fastest level.
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5 Contact Information

Contact Information
ETAS Headquarter
ETAS GmbH
Borsigstraße 24

Phone:

+49 711 3423-0

70469 Stuttgart

Fax:

+49 711 3423-2106

Germany

Internet:

www.etas.com

ETAS Subsidiaries and Technical Support
For details of your local sales office as well as your local technical support team
and product hotlines, take a look at the ETAS website:
ETAS subsidiaries

Internet:

www.etas.com/en/contact.php

ETAS technical support:

Internet:

www.etas.com/en/hotlines.php
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